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1 Sales pro 

The Sales pro module enables you to improve your sales process using sophisticated 

sales methods. With reliable forecasts and comprehensive control functions, you can 

achieve your sales targets more easily and complete routine tasks considerably faster. 

Sales pro helps you to set the focus on sales. 

All functions of the Sales pro module are available in the standard languages. 

The following diagram illustrates how the CAS genesisWorld Sales pro module can sup-

port you. 

 

The CAS genesisWorld Sales pro module helps you to organize your sales structure and 

processes: 

Lead: First contact with prospective customers 

With Sales pro, CAS genesisWorld features a new data record type: Lead. 
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The Lead data record helps sales staff to enter information about the first contact made 

with a prospective customer. First contact usually occurs on company websites, trade 

shows or other such events. 

During first contact, certain data of the prospective customer is usually gathered in a 

form on a website, from business cards at a trade show, or from a lead questionnaire. 

In the Sales pro module, this data is saved in the Lead data record. Certain data can be 

entered in this data record, for example, the preferred or most common contact method 

of the person. 

All information available about a prospective customer is then saved in CAS genesis-

World and accessible in the Lead data record. Before a prospective customer is trans-

formed into a valid address and an opportunity is created, the data can be qualified and 

completed if necessary. 

Leads and Opportunities 

You can transfer leads to another data record for further processing, for example, if you 

want to create a new task or opportunity with the lead contact data. 

You can enter different contact persons, competitors, and salespersons into opportuni-

ties. 

Sales Methodology 

A methodical approach to sales is supported by criteria catalogs. Criteria catalogs can be 

developed or assumed from other standards. 

You can easily assess sales completions using the automatic probability calculation. 

Sales process and documents 

You are provided with comprehensive support through all phases of sales process man-

agement, from the first lead and qualification, through to the opportunity and after-sales 

management. 

Create different sales processes to represent workflows using different activities and 

structure them with milestones. 

With sales processes, you can easily create and manage necessary documents, such as 

information material, offers, invoices, and so on. You can also create and manage the 

corresponding templates. 

Analysis 

The Sales pro module provides evaluations and reports, which you can create in a new 

view according to various criteria. 
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2 Working with leads 

The sales process begins with a contact: Someone contacts you and shows an interest in 

your products or services. At least the name of the prospective customer is registered. 

The information gathered during first contact is entered in the new Lead data record 

type. 

At the same time, the corresponding address can be checked and entered in a new data 

record. The employee responsible can be entered in the lead. 

You can then create a new data record from the lead, for example, an opportunity. 

Specific lead content can be adopted automatically into the opportunity. 

If your company prefers project-oriented work, you can also create a project based on 

the lead data record. 

After a trade show or after you finished a phone call, you can enter the contact informa-

tion from business cards or trade show questionnaires in a CAS genesisWorld lead. The 

lead is processed in three steps: 

 You enter the address and additional information. 

 You qualify the address. 

 You create an opportunity or another data record from the lead. 

The Status field is automatically completed. This field indicates the steps that have al-

ready been executed: 

You can tell if the lead is new, whether the address has already been entered and 

qualified, or if a new data record has been created. 

You can customize the Lead data record type by adding further fields depending on 

your requirements. 

You can also define input assistance options for existing and new fields, for example, 

for Source, Product and Volume. 

Please contact your administrator if necessary. 

2.1 Entering and qualifying leads 

The Lead data record type enables you to quickly and easily enter the most essential 

data of an initial contact with the customer. 

 All available information is entered in the Address information field. 

 In the Action field, you enter the actions that still need to be executed, for example, 

the create appointment action. 

 With Report, you create lead analyses from specific report templates. 
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Qualifying addresses 

In principle, you have two options for qualifying an address, i. e. for linking with an ad-

dress. 

 Use the Select/display customer button to link the lead with an existing address. 

 With Reset selection, you remove the link to an existing address. 

 Use the Qualify button to create a new address using the text in the Address 

information box and link this address with the lead. 

After clicking the Qualify button, a prompt opens. Choose whether you want to create 

and link an individual contact, a company, or a contact person. 

Notes 

The address information is only automatically transferred to the new address if the 

user is allowed to use the address wizard. The respective right is assigned by the ad-

ministrator. Please contact your administrator if necessary. 
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If the respective right has not been assigned, an address data record opens and the in-

formation has to be entered manually. 

The address information is only automatically transferred to the new address if you 

are online. Qualifying uses a Web-service from CAS Software AG. If you are offline, you 

can create a new address manually. 

You may only be able to save a lead if an address is linked to the lead. Users with suffi-

cient rights can change these settings in the lead settings, see chapter "Additional set-

tings" on page 34. 

If a lead is created from an address, then this address is automatically linked with the 

lead via the Customer link type. When you are finished, the lead will already have been 

qualified. 

2.2 Creating a new data record from a lead 

If you have qualified an address in a lead, you can create a new data record from the lead 

later in the sales process. 

The Address information is only automatically transferred to the new address if you 

are allowed to use the address wizard. 

The necessary rights are granted to you by the administrator. Please contact your 

administrator if necessary. 

 Open a lead. 

 Click the Create button. 

The Create new data record window opens. 

 Select the desired data record type from the drop-down list. 

Thereby, you determine which new data record type is created. The data record types 

you can choose from here are defined in the settings for leads, see chapter "Field 

assignment" on page 31. 

The following steps are then automatically executed by the Sales pro module: 

 A new data record is created (e.g. an opportunity). Certain field values from the lead 

are entered in the fields of the new data record. 

The fields that are transferred to the new data record are defined in the settings for 

leads, see chapter "Field assignment" on page 31. 

Fields that have not been assigned are noted in the notes field of the new data record. 

 A general link is used to link the new data record with the lead. 

 The link between the lead and the address is applied to the new data record. 

Finally, both the lead and the new data record are linked with the address. 
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2.2.1 Opportunities: special features 

If you create a new opportunity data record from a lead, you can check the new opportu-

nity for duplicates. For links to the customer, special rules apply.  

The lead is linked to an address. When creating an opportunity, the program checks 

whether opportunities already exist for this address. 

If the linked address is a company or a contact person, all opportunities of this company 

and all opportunities of the contact persons are checked. 

You can therefore be sure that all opportunities are unique and are only processed once. 

You activate duplicate checking in the settings, see chapter "Additional settings" on 

page 34. 

Changing links automatically 

 

If a lead is linked to an address with the link type Customer, the link is adopted in the 

newly created opportunity. 

If the lead is linked to a contact person, the contact person is also entered in the new op-

portunity as a Customer link type. 
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With the Enter company in Customer field of Contact person option, the company of 

the contact person is identified and entered as a Customer link type. The contact person 

who was linked originally is then linked with the opportunity using a Contact person link 

type. 

3 Opportunities in the Sales pro module 

The Sales pro module helps you to implement a methodical sales approach and provides 

functions and commands for the necessary sales processes. The opportunity data record 

is enhanced with additional tabs and features. 

 

 On the General tab, you will find functions, for example, for calling and linking contact 

persons. 

 Use the Contact person tab to enter contact persons in the customer's company and 

their influence on your success in closing an opportunity. 

 On the Competitor tab, you can add the name of potential competitors and the in-

fluence they may have on the customer's purchasing decision. 
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 On the Criteria catalog tab, you can select a criteria catalog. The influence of certain 

criteria helps you to obtain knowledge about the customer and the potential success 

of the opportunity. 

 On the Sales process tab, you can select a specific sales process. With this sales pro-

cess, you can plan the activities to successfully close an opportunity. 

 With systematic processes and the corresponding functions, you can evaluate comple-

tions using the automatic probability calculation, see chapter "Probability calculation" 

on page 18. 

Opportunities can be created from a lead. 

Before you can save a new opportunity, you must enter a customer. The entered cus-

tomer is linked to this opportunity with the Customer link type. 

The Customer link type can only be used once for an opportunity. 

If you link a second address with the Customer link type, the previous link is transformed 

into a general link. 

3.1 Functions on the General tab 

On the General tab, you can record the Salesperson, Status, Source, and further impor-

tant information on the opportunity. 

Salespersons 

In the Sales pro module, the fields Salesperson, Salesperson 2, and Salesperson 3 are 

available on the General tab in opportunities. In these fields, you can enter addresses 

that are linked to the opportunity with special link types. 

In the Desktop Client settings, you can enter favorites for the selection of this address. 

You can find more information and an example in the sales settings, see chapter "Sales" 

on page 32. 

The field names and the names of link types can be changed by your administrator. 

Please contact your administrator if necessary. 

Linking 

If you link the opportunity with any new data record, a prompt is displayed. You can now 

also link the new data record with all addresses to which the opportunity is linked. 

For example, you can click New link and select Appointment. A window opens display-

ing a list of all addresses that are linked to the opportunity. Now, select the addresses 

you want to link with the new appointment. 
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When linking an opportunity with any existing data record, the customer address of the 

opportunity is automatically linked to the existing data record. 

End field 

If you do not fill in the End field of an opportunity, a notification is displayed during 

saving. 

A large number of the evaluations for opportunities are made based on the End field, 

for example, the forecast for a certain time period. Therefore, we recommend that you 

always fill in this field. If you do not fill in this field, the opportunity will not be included 

in the respective evaluation. 

Participants of an opportunity 

Users can automatically be entered in the Salesperson, Salesperson 2, or Salesperson 3 

fields. In this case or if you manually edit these fields, these users can also be automati-

cally entered as participants with certain rights in the opportunity. You can define individ-

ual specifications in the sales settings, see chapter "Sales" on page 32. 

Automatic probability calculation 

The probability of an opportunity can be calculated automatically based on the para-

meters on the Contact person, Competitor, Criteria catalog, and Sales process tabs, 

see chapter "Probability calculation" on page 18. 

Phase 

If a milestone with a new phase has been reached in the sales process, the new phase is 

automatically entered in the Phase field. 

The names of the respective phases depend on the specifications of the used sales 

process, see chapter "Sales processes" on page 28. 

3.2 Functions on the Contact person tab 

On this tab, you can record the contact persons of an opportunity and their Attitude. 

 Click the Add button. 

The Contact person window opens. 

 Click Search address. 

The Search window opens. You can only enter addresses that have been recorded in 

CAS genesisWorld as contact persons. 
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If you have already linked an address as a customer to the opportunity, the search 

field is already filled in with the contact person(s) of this company. 

 

 Select the Role you want to assign to the contact person. 

All possible roles are determined by the administrator. Please contact your administra-

tor if necessary. 

All links to addresses with the respective link types are displayed on the Dossier tab of 

the Addresses list. 

 Enter the Weighting. 

 Select whether this weighting is to be of a positive, neutral, or negative Attitude. 

These values influence the probability calculation, see chapter "Probability calculation" 

on page 30. 

Red indicates a probability of under 33%. 

Yellow indicates a probability of between 34% and 66% and 

Green indicates a probability of more than 66%. 

 If required, enter a comment for each contact person in the Comment field. 

3.2.1 Partial probability for contact persons 

The overall probability of an opportunity is calculated using the weighted partial proba-

bilities of the areas Contact person, Competitor, Criteria catalog, and Sales process, 

see chapter "Probability calculation" on page 30. 
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The partial probability for the contact persons is the sum of the values in the attitude and 

opinion fields of each contact person. The attitude can range from -1 (negative), 0 

(neutral) to +1 (positive). 

The minimal probability is 0 %. If the weighted sum is negative, the probability of 0 % is 

displayed. 

Example 

Contact person 1, weighting: 50, Attitude: 0 

Contact person 2, weighting: 30, Attitude: -1 

Contact person 3, weighting: 20, Attitude: +1 

Probability = 50*0 + 30*(-1) + 20*1 = 0 - 30 + 20 = -10 / 100 = -0,1 = -10% 

As this value is negative, the probability is 0%. 

3.3 Functions on the Competitor tab 

On this tab, you can enter the competitors for the opportunity and their competitive po-

sition. 

 Click the Add button. 

The Competitor window opens. 

 

 Click Search address. 

The Search window opens. You can only enter addresses that have been recorded in 

CAS genesisWorld as competitors. 
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If an address is not recorded in CAS genesisWorld, you can directly enter the name of 

a competitor in the input field. 

 Select a Competitive strength between 0 and 10, with 10 as the strongest value. 

The Competitive strength reflects an evaluation of the competitive position of com-

petitors. Entries in this drop-down list are pre-defined and cannot be changed. 

 If required, enter a comment for each competitor in the Comment field. 

The probability for the successful conclusion of an opportunity is based on the 

strongest competitor, see chapter "Probability calculation" on page 30. 

If you have entered a competitive strength of 10 for the strongest competitor, the 

probability is 0%. If the strongest competitor has a competitive strength of 4, the 

probability is still 60%. 

The values are displayed with different colors, as on the Contact person tab. 

3.3.1 Partial probability for competitors 

The overall probability of an opportunity is calculated using the weighted partial proba-

bilities of the areas Contact person, Competitor, Criteria catalog, and Sales process, 

see chapter "Probability calculation" on page 30. 

The partial probability for competitors is calculated based on the strongest competitor. 

Select a Competitive strength between 0 and 10, with 10 as the strongest value. 

If the maximum strength of all competitors is rated 0, the probability of completing the 

opportunity is 100%. 

If the maximum strength of all competitors is rated 10, the probability of completing the 

opportunity is 0%. 

The formula is 100 - (maximum strength * 10) = x [%] 

Example 

Competitor A: 1 

Competitor B: 3 

Competitor C: 5 

The maximum strength is 5, that is, the probability is 50%. 

As the program cannot differentiate whether a competitor has not yet been entered or 

does not exist, an initial value of 100% is set. 
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4 Sales methodology 

With its criteria catalogs, the Sales pro module supports your sales methodology. You 

can create, edit, use and change one or more criteria catalogs. Criteria catalogs can be 

used for project business, for standard sales processes, for services and so on.  

Your sales processes are further supported by the automatic probability calculation 

according to entered criteria. With this assessment function, you can control your sales 

activities. 

4.1 Criteria catalog 

First, select a criteria catalog and then define the characteristics of each criterion for the 

customer of the opportunity. 

You can create and use several criteria catalogs with the Sales pro module. Default char-

acteristics of each criterion can be selected in the settings. 

Users with sufficient rights can define one or multiple criteria catalogs, criteria, and char-

acteristics in the settings, see chapter "Criteria catalogs" on page 25. 

 

Notes 

Criteria catalogs are activated, in other words, made available to users. If you no longer 

want to use a criteria catalogue, you can deactivate it. 
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Existing opportunities with reset criteria catalogues remain unchanged. You cannot use 

a deactivated criteria catalogue for new opportunities. 

The names of criteria can be changed, even though a criteria catalog is in use. 

Points and weightings of single criteria cannot be changed as long as a criteria catalog 

is in use. This restriction exists due to the fact that the probability calculation for the 

criteria catalog is made based on this data. This (partial) probability is then taken into 

account for the probability calculation for the opportunity. 

If changes to the weighting were permitted, changes in the probability could occur. 

Such undesired changes can thereby be prevented. 

4.2 Probability calculation 

You can calculate the probability for an opportunity on the General tab. The calculation 

is based on the different parameters recorded on the Contact person, Competitor, Cri-

teria catalog, and Sales process tabs, see chapter "Probability calculation" on page 30. 

 Activate the Use calculated probability checkbox. 

If you deactivate the checkbox, you can manually enter a probability. 

 Click Recalculate probability to recalculate the probability. 

Such a recalculation could be required if, for example, you have changed the contact 

person, competitors, and so on, in the opportunity. 

5 Sales process 

In the Sales pro module, you use one or more sales processes to help plan your sales ac-

tivities with work processes or workflows with activities and milestones. 

The sequence of actions of a process is predefined and actions can easily be entered. 

One or several sales processes with milestones and corresponding activities are defined 

in the settings for sales processes, see chapter "Sales processes" on page 28. 

The sales process from lead to opportunity to after-sales management is clearly defined 

and follows a logical, plannable sequence. 

 Open an opportunity on the Sales process tab. 

 Select a Sales process. 

 Activate the checkbox with the activity you want to do next. 

The respective activities are defined in the settings for sales processes, see chapter 

"Sales processes" on page 28. 
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 Click on the corresponding button next to the desired activity. 

Depending on the activity, a corresponding window opens. In this window, you can 

execute the desired activity or create a new data record. The data record with the task, 

the phone call, and so on, is automatically linked with the opportunity. 

 

After you have created an activity, the date on which the data record was created is dis-

played in the corresponding field. Furthermore, the date on which the last activity has 

been performed is displayed in the Last action on field on the General tab. 

Notes 

Sales processes are activated, in other words, made available to users. If a sales process 

is no longer being used, you can deactivate it. Existing opportunities with an unpub-

lished sales process remain unchanged. You cannot use a deactivated sales process for 

new opportunities. 

The name of milestones and activities can be changed, even if a sales process is being 

used. The assignment of an activity to a phase cannot be changed. The points and 

weightings of an activity and the respective activity can also not be changed retroac-

tively. 

This restriction exists due to the fact that automatic processes of the opportunity are 

based on this data, for example, the automatic calculation of probability. 
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6 Evaluating opportunities 

You can easily create opportunity evaluations in a new view by entering different criteria 

and you can change them directly in this view. 

Evaluations can be displayed in a chart and you can export this chart as an image file. 

For this purpose, create an Opportunity analysis view with the View wizard. 

 Click New > View in the File menu. 

The View wizard will open. 

 Select Opportunity analysis as view type. 

 Select the desired template. 

The View wizard contains several templates for the Opportunity analysis view that 

differ in filter settings and chart type. 

If you want to make evaluations, especially with regard to time periods, you have to fill 

in the End field in opportunity data records. 

If you save an opportunity without filling in this field, you will receive a message. 

6.1 Settings when creating a view 

You can define the content for this view in the View wizard or in the settings of each 

view: 

 Go to the View tab or the respective page of the View wizard to enter your filter cri-

teria. 

 Go to the Chart tab to define settings for the chart of the evaluation. 

You can also change both filter criteria and settings for the chart directly in the view with-

out opening the Properties window for the view. 

You can create or change views if your administrator has given you the necessary 

rights to change the navigator. Please contact your administrator if necessary. 

6.1.1 View: filter criteria 

Go to the View tab or the respective page of the View wizard and define central settings. 

With those settings, you can also define which filter criteria you want to display directly in 

the view in order to work with the data. 

 In Display filter criteria for opportunities, you can select 3 table fields and 

conditions. 
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Filter criteria for opportunities are displayed in the view. The filter value for each filter 

condition can be directly entered in the view. 

 

You can also define further criteria in the view itself. Filter criteria that have been selected 

in the view properties are displayed in different panes with descriptions, such as Actions, 

Opportunities, and so on. 

 

 If you activate the Display filter criteria for period option, a pane with a drop-down 

list is displayed in the view. 

With the Period from/to entry in the drop-down list, two more fields are displayed in 

which you can define the start and end time of a period. With the User-defined entry, 

a field with a button that opens a box with specific dates is displayed. 

 Activate the Display filter criteria for sales option to display the salesperson fields in 

the view. 

 With Display filter criteria for addresses, you can display filter criteria for customers, 

competitors, contact persons, and so on. 
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The drop-down list contains all link types for addresses. 

 If you activate the Display filter criteria for product items option, filter criteria for 

product items are displayed. 

The filters refer to the product items that are entered in the opportunities. 

Currency settings 

All views for the Opportunities analysis contain special filter options for the currency 

that is set in the respective opportunities. 

 If you activate the Display opportunities in their respective currency option, only 

the information from the opportunities is taken into account. 

Thereby, all opportunities are displayed regardless of their currency. You select this 

option if you maintain all opportunities in one currency or if you want to make an 

analysis without regarding the currency, for example, if you only want to find out the 

number of opportunities. 

 With the Display only opportunities in drop-down list, you can define that only 

opportunities in the selected currency are displayed. 

You select this option if you only want to evaluate opportunities with a certain 

currency. 

 If you activate the Display all opportunities and convert them into the currency 

option, all opportunities that result from other filter criteria are taken into account 

If prices of product items are entered in different currencies, the total sum of product 

items is converted in the currency selected in the Display only opportunities in 

option. Subsequently, the converted values are displayed in the view. 

The Base currency which is used as default currency in your company is defined by the 

administrator. If you have not yet selected an entry, the Base currency is selected by 

default in any drop-down list for currency selection. 

The administrator defines the exchange rate and which currencies are displayed in the 

drop-down list. 

The defined exchange rates refer to the conversion of foreign currency to the defined 

Base currency. The options for conversion depend on the individual settings of your 

company. Please contact your administrator if necessary. 

6.1.2 Chart settings 

In principle, the chart settings for the chart of the Opportunities analysis view are the 

same as for any usual Chart view in CAS genesisWorld. 
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The following settings differ from the settings for other chart views in CAS genesisWorld. 

 The chart always refers to the opportunity which means you do not select a data 

record type. 

 You define filter criteria in the View tab or directly in the view and not in the Chart 

tab. 

 In the Displayed values section, you define the field values you want to see and how 

you want to display them. You can choose from horizontal and vertical bar charts, pie 

charts, or Sales funnel. 

6.2 Opportunities analysis view 

This view consists of several areas. 

 

 Actions 

In this area, you can select actions for the opened view. 

 Click Refresh if you have made changes to the filter criteria (2). Then, the view will be 

refreshed. 

 With Reset, you can display the view as it is defined in the view properties. 

 Save saves the current view in the view properties. 
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 Filter conditions 

This area displays all panes for all filter criteria that you have activated in the view proper-

ties. If you, for example, activate the Display filter criteria for period option, the Time 

frame pane is displayed. 

The Opportunities pane is always displayed. 

 Click More filter criteria in the panes for opportunities and addresses. 

The Filter for window opens. In this window, you can enter additional filter criteria. 

 Click the small arrow in the lower right corner of a pane. 

A window opens in which you can change the Table field and the Condition of the 

displayed filter criteria directly in the view. 

In principle, the filter criteria correspond to the link search, for example, search all oppor-

tunities which are linked to a specific address. 

 More filter conditions 

If the width of the screen cannot display all active panes, they are displayed as icons. 

 Click the button to open the corresponding settings. 

 List of opportunities 

This list displays all opportunities which are included in the view according to your set-

tings. You can therefore, for example, save interesting opportunities as static list views in 

the navigator. 

You can change the width of the list and the chart by moving the border line of the two 

areas. 

 Chart 

This area displays bar charts, pie charts, or a sales funnel. 

 Functions for the chart 

 With Display/Hide chart properties, you can display the view properties. 

In the displayed properties, you can adjust the Displayed values, the Displayed data, 

and the Display. 

 Export chart opens the Windows file selection box. 

The chart can be saved as an image file. 
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6.3 Using price/discount lists 

You can now maintain and include price/discount lists with Sales pro. Using these lists, 

you can define different prices depending on the minimum quantity for a product. These 

prices are included when calculating the price offer for a single product item of an op-

portunity. 

Therefore, price/discount lists are convenient for defining scaled prices for a product de-

pending on the ordered quantity of items. The Prices and discounts area in the Details 

tab is displayed for companies and individual contacts. 

You can use the Customer price and/or Customer discounts fields to note down indivi-

dual agreements with customers. All available price/discount lists and individual agree-

ments with customers can be recorded in the respective fields in company data records 

and individual contacts. 

Users with sufficient rights can define price/discount lists in the price lists and discount 

lists settings, see chapter "Price lists" on page 34, "Discount lists" on page 36. 

If the Sales pro license is not activated, you will not see the Prices and discounts area 

in the Details tab for companies and individual contacts. 

Prices and discounts that have been entered are taken into account for calculations 

even if a user without access to price/discount lists has created opportunities. 

7 Sales pro settings 

In the settings for the Sales pro module, you define standards for sales methodology and 

sales processes, for example, criteria catalogs. 

 Click Settings in the Tools menu. You will find all the settings on the Sales pro tab. 

7.1 Criteria catalogs 

On this tab, you can create, activate, deactivate, and duplicate criteria catalogs. You can 

also duplicate existing criteria catalogs. 

 If you click New or Edit, the Create new/Edit criteria catalog window opens.  

In this window, you create Criterion. 

 You can enter Ratings for each criterion. 

In addition, the rating is weighted using a points system, see chapter "Probability 

calculation" on page 30. 

 If you activate the Default option in a rating, the rating is selected as default. 

The rating can be changed at any time. 
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Changing the criteria catalog 

Criteria catalogs that are currently in use cannot be changed. 

You can only make limited changes to a criteria catalogue that is used in opportunities. 

As a rule, you can only change the names of criteria, but not the ratings or points that are 

assigned to the respective rating. 

If you need to change a criteria catalog, we recommend doing the following: 

 Duplicate the existing criteria catalog and adapt it to your needs. 

 Activate the new criteria catalogue. 

 Mark the previous criteria catalogue and click Reset. 

This deactivated criteria catalog is still available in all existing opportunities. In these op-

portunities, the deactivated criteria catalog can still be used. 

However, when you create new opportunities, you will only be able to select and use the 

new criteria catalog. 

Example of a criteria catalog 

Criteria and the assessment of each criterion are useful if you want to assess the cus-

tomer and the potential success of the opportunity. 

Each time a rating for a criterion has been entered, the potential success of the oppor-

tunity increases. The more points a criterion has been assigned, the more likely it is that 

the opportunity will be closed successfully. 

Please note that the criteria should be worded positively, because the probability of the 

success of an opportunity increases when a rating has been given. This is set in the prob-

ability calculation, see chapter "Probability calculation" on page 30.  
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7.1.1 Partial probability for criteria catalogs 

The overall probability of an opportunity is calculated using the weighted partial proba-

bilities of the areas Contact person, Competitor, Criteria catalog, and Sales process, 

see chapter "Probability calculation" on page 30. 

The partial probability for a criteria catalog is the relation between the sum of all 

reached/selected/marked points and the sum of the maximum number of attainable 

points. 

Example 

Criterion 1 

 Rating 1   Points: 20 

 Rating 2   Points: 5 

 Rating 3   Points: 55 

Criterion 2 

 Rating 1   Points: 10 

 Rating 2   Points: 12 

 Rating 3   Points: 40 
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Criterion 3 

 Rating 1   Points: 34 

 Rating 2   Points: 13 

 Rating 3   Points: 27 

Maximum: Criterion 1: 55 + Criterion 2: 40 + Criterion 3: 34 = 129 (corresponds 100%) 

Ratings: Criterion 1: 5 + Criterion 2: 10 + Criterion 3: 34 = 49 

Probability = (49 * 100) / 129 = 37.98 %, rounded up to 38%. 

7.2 Sales processes 

On this tab, you can create one or more sales processes, activate them, or deactivate the 

ones you do not want to use anymore. You can also duplicate existing sales processes. 

You can select any names and assignments for milestones and activities. The points for 

activities can be assigned arbitrarily. 

 

 Click the New and Edit buttons. 

The Edit sales process window opens. 
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 In the Edit sales process window, you can create Milestones. 

You can assign each milestone to a phase. If a milestone with a new phase has been 

reached, the new phase is automatically entered in the Phase field on the General tab 

of the opportunity. 

 You can then create Activities for each milestone. 

An activity can be a task, a document, an e-mail, a project, and so on. You can define a 

Template for each activity. 

The Other action in the Activity window is not based on a CAS genesisWorld data re-

cord type. You can therefore not enter a template for this action and you will not find 

a button in the opportunity to create such a data record. 

 Define Points for each activity. 

These points are reached if the activity has been created. 

Changing the sales process 

Sales processes that are currently in use cannot be changed. Changing sales processes is 

the same as changing criteria catalogs, see chapter "Criteria catalogs" on page 25. 

7.2.1 Partial probability for sales processes 

The overall probability of an opportunity is calculated using the weighted partial proba-

bilities of the areas Contact person, Competitor, Criteria catalog, and Sales process, 

see chapter "Probability calculation" on page 30. 

The partial probability of a sales process is the relation between the sum of all 

reached/selected/marked points and the sum of the maximum number of attainable 

points. 

Example 

Milestone 1 

 Activity 1   Points: 4 

 Activity 2   Points: 6 

 Activity 3   Points: 1 

Milestone 2 

 Activity 1   Points: 3 

 Activity 2   Points: 4 

 Activity 3   Points: 1 
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Milestone 3 

 Activity 1   Points: 1 

 Activity 2   Points: 1 

 Activity 3   Points: 7 

Total: 9 process steps with a total of 28 points, i.e. 100%. 

The progress after 5 process steps is 18. 

Probability = (100 * 18) / 28 = 64.28 %, rounded up to 64%. 

7.3 Probability calculation 

The probability of an opportunity is calculated using the weighted partial probabilities of 

the areas Contact person, Competitor, Criteria catalog, and Sales process. 

On the Probability calculation tab, you define the influence of Competitor, Contact 

person, Criteria catalog, and Sales process on the automatic probability calculation. 

 Activate the Use calculated probability checkbox. 

If you deactivate the checkbox, you can manually enter a probability in opportunities. 

You can assign any value between 0 and 100 for the points that define the influence of 

partial probability. 

The sum is assumed to be 100 %. Depending on the points, you obtain the respective 

percentage with which the partial probability influences the calculated probability of 

winning an opportunity. 

Example of a calculation 

Weighting in % Type Probability in % = 

30 Contact person 0 0 

40 Competitors 30 12 

20 Criteria catalog 38 7.6 

10 Sales process in progress 64 6.4 

100 Sum  26 

The calculation formula is usually: (Weighting/100) * Probability 

For example: (20/100) * 38 = 7.6 

Thus, the probability of winning the opportunity is 26%. 
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7.4 Field assignment 

You can create a new data record from a lead during the sales process. The new data 

record can be an opportunity, a task, a project, and so on. 

 Use the Target drop-down list to select the data record you want to assign fields to. 

You can define assignments for several data record types. In addition, you can make 

assignments for each data record type.  

The Lead fields section displays the fields of the lead that you want to transfer to the 

new data record. 

In the process, only fields of the same type will be offered. In other words, date fields, for 

example, can only be assigned to date fields. 

 

 Click New assignment to display an additional row. 

Notes 

The Notes field of a lead is always transferred to the identical field of the new data re-

cord. 

Additionally, all values of the lead fields that have not been assigned are entered in the 

Notes field of the new data record. 

When creating a new data record from a lead, only the data records with at least one 

field assignment are displayed. 

For example: let's say you would like to create a document from lead. The document 

data record type is not displayed by default. Thus, you need to define a field assign-

ment, for example, subject to subject. 
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7.5 Sales 

On these tabs, you enter your sales department's structure. 

For this purpose, you define Favorites for the Salesperson, Salesperson 2, and Sales-

person 3 fields. By selecting Favorites, you can find your preferred selection for the 

salesperson fields on the General tab of the opportunity. The favorites are displayed in 

the desired order in the drop-down list for the Salesperson, Salesperson 2, and Sales-

person 3 fields. 

You can enter any CAS genesisWorld addresses on the Salesperson, Salesperson 2, and 

Salesperson 3 tabs. If you also want to enter CAS genesisWorld users, an employee data 

record for the respective users is required. Employee data records are created by the ad-

ministrator. Please contact your administrator if necessary. 

 

If such an address of a user is selected for one of the Salesperson, Salesperson 2, or 

Salesperson 3 fields, the respective user can be entered as participant to the 

opportunity. 

 Activate the Add as participant option and assign the desired Access rights. 

 On the Field assignments tab, you define rules to automatically fill in the 

Salesperson, Salesperson 2, and Salesperson 3 fields. 

Example 

Your company works with indirect sales channels and you sell your product via sales 

partners. They are looked after by a sales partner manager. With larger projects, the sales 

partner managers are supported by key account managers. 
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The field names are changed by the administrator, see chapter "Changing link types" on 

page 39. 

 Rename Salesperson to Sales partner. 

 Rename Salesperson 2 to Sales partner manager. 

 Rename Salesperson 3 to Key account manager. 

Subsequently, you can work with the adjusted field names on the Sales tab. 

 On the Sales partner tab, click on the Add button to select the respective addresses  

All addresses that have been linked to a data record using the Sales partner link type 

are listed on the Sales partner tab. 

 On the Partner manager and Key account manager tabs, you add addresses from all 

internal consultants or users, and so on. 

 On the Field assignments tab, you define which partner manager is responsible for 

which sales partner and which key account manager is responsible for which partner 

manager. 

If you create a new opportunity and select a certain partner in the Sales partner field, 

the Partner manager and Key account manager users are automatically entered in 

the respective fields. 

 If you have activated the Participant option on the Partner manager and Key 

account manager tabs, these users are also automatically entered as participants in 

the opportunity. 

Opportunities can also easily be evaluated with regard to Sales partner, Partner 

manager and Key account manager. 

Notes 

If the user who is currently logged on to CAS genesisWorld has been entered as a 

favorite on the Salesperson tab, this user is also automatically entered in the respec-

tive field when creating an opportunity. 

If the user is entered on several Salesperson tabs, he is only entered in the one field of 

the opportunity. 

The Salesperson, Salesperson 2, and Salesperson 3 tabs are regarded with 

descending priority: if the logged on user is entered on the Salesperson and Salesper-

son 3 tab, he is only entered in the first field of the opportunity. 

If a salesperson field in an opportunity is already pre-allocated with the logged on 

user, more salespersons are not automatically entered. 

Remove the salespersons you have already entered and select them again from the 

salesperson favorites. The automatic enter function is reactivated.  
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7.6 Additional settings 

Go to this tab to define various settings for leads and opportunities. 

 With the Link lead to an address before saving option, you define whether a lead 

needs to be linked to an address. 

If you activate the option, a lead cannot be saved without an address linked to it. 

 If you activate the Check for duplicates when transforming a lead into an oppor-

tunity option, you can prevent duplicate linked opportunities with addresses. 

If you create an opportunity from a lead, the Opportunities related to the contact 

were found window opens. You can choose whether you want to create a new 

opportunity or work with the existing opportunity. 

Basically, when running a duplicate check, all the opportunities are displayed for all 

the addresses which are linked to the lead. 

 If you do not want to check all existing opportunities, you can restrict the volume of 

addresses to be checked with a filter. 

 With Hide "Person responsible" and "Deputy" fields, you can define whether the 

person responsible and the deputy are to be displayed in the opportunity. 

 With the Sort order of names option, you can define by which fields the lists on the 

Salesperson, Salesperson 2, and Salesperson 3 tabs are sorted. 

This option can be helpful for lists with a large volume. 

7.7 Price lists 

Using price lists, you can define discounted prices for specific products. The prices can be 

staggered according to the minimum purchased quantity. 
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Consequently, you can set different unit prices for the same product depending on how 

many units or how much of a product is purchased. 

Example 

You sell flooring for 9,95 Euros per square meter. With a minimum purchase quantity of 

10 square meters, the price is reduced to 6,95 Euros and with an even larger quantity to 

4,95 Euros per square meter. 

Price lists tab 
 Click Create new price list and enter a name for your price list. 

The new price list is then highlighted and displayed. 

 Clicking Delete price list deletes the selected price list. 

 Clicking the Create new price button opens the Create new price window. 

 

 Select a Price list. 

 Enter the product name or click the Search products button to select a product. 

You do not have to enter the full product name, the first few letters will suffice. Now, if 

you click another field, the product name is completed automatically. If the letters you 

entered do not result in a hit, another window will open from which you can select the 

product. 

Any hits returned will be products which agree with the product search filter in the 

Sales, Project, and Helpdesk modules. When using the default settings, these are pro-

ducts for which the Active option has been selected on the General tab. The settings 

are changed by the administrator in the Management Console. Please contact your 

administrator if necessary. 
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 Define the Minimum amount. 

 Enter the Price you want to use for this product and the defined minimum purchase 

quantity. 

Customer prices tab 

On the Customer prices tab, you can see personally defined price lists which have been 

created for specific customers. You can define these price lists on the Details tab in the 

respective address data records. 

The customer price is always taken into account, regardless of whether or not other price 

lists exist for a customer. 

The Prices and discounts area on the Details and Bill tabs is displayed for companies 

and individual contacts. 

If the Sales pro license is not activated for a user, the Prices and discounts for com-

panies and individual contacts will not be displayed to them. Entered prices and dis-

counts are still taken into account if said users create an opportunity for a customer 

and want to calculate the prices or offered prices. 

If you are using the Easy Invoice module, you can create a customer discount list on 

the Account tab. 

7.8 Discount lists 

Using discount lists, you can create percentage discounts for specific products. As with 

price lists, you can stagger discounts according to minimum purchase quantities. 
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The discount automatically influences the offered price. If, for example, you offer 10% 

discount on every purchase of 10 units, the discount is automatically calculated when the 

number of units sold equals 10 or more. 

Discount lists tab 
 Click Create new discount list and enter a name for your discount list. 

The new discount list is then selected and displayed. 

 Clicking Delete discount list deletes the selected discount list. 

 Using the Create new discount button opens the Create new discount window. 

 

 Select the Discount list. 

 Enter the product name or click the Search products button to select a product. 

You do not have to enter the full product name, the first few letters will suffice. Now, if 

you click another field, the product name is completed automatically. If the letters you 

entered do not result in a hit, another window will open from which you can select the 

product. 

Any hits returned will be products which agree with the product search filter in the 

Sales, Project, and Helpdesk modules. When using the default settings, these are pro-

ducts for which the Active option has been selected on the General tab. The settings 

are changed by the administrator in the Management Console. Please contact your 

administrator if necessary. 

 Define the Minimum amount. 

 Enter the Discount you want to use for this product and the defined minimum 

purchase quantity. 
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Customer discount tab 

On the Customer discount tab, you will see personalized discounts which have been 

created for specific customers. You can define these discount lists on the Details tab in 

the respective address data records. 

The Prices and discounts area on the Details and Bill tabs is displayed for companies 

and individual contacts. 

If the Sales pro license is not activated for a user, the Prices and discounts for com-

panies and individual contacts will not be displayed to them. Entered prices and dis-

counts are still taken into account if said users create an opportunity for a customer 

and want to calculate the prices or offered prices. 

If you are using the Easy Invoice module, you can create a customer discount list on 

the Account tab. 

8 Management Console settings 

The administrator can define and change certain settings and rights for the Sales pro mo-

dule in the Management Console. 

8.1 Licenses for Sales pro 

The Sales pro module requires a separate license. Users without a license will not be able 

to use its functions. Accordingly, the license must be activated for users who are sup-

posed to use the functions of the Sales pro module. 

Only users with a Sales pro license have access to the following functions: 

 Access to the data record type Lead. 

 Access to the Contact person, Competitor, Criteria catalog, and Sales process tabs. 

 Access to views for evaluating opportunities. 

Access to create, change, and view data records and views is dependent on the indivi-

dual rights of each user. 

 Only users with a Sales pro license can be granted the right to administer settings for 

Sales pro in the Desktop Client. 

 Users without a license can view opportunities, but without the mentioned functions 

described above, i.e. 

without the option to use or change a calculated probability, 

without the Salesperson, Salesperson 2, or Salesperson 3 fields, 

without the Contact person, Competitor, Criteria catalog, and Sales process tab. 
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8.1.1 Sales pro: administrator 

It is usually one user who defines the sales structure, creates and maintains criteria cata-

logs and processes, and so on. This user needs to be assigned special rights by the ad-

ministrator in the Management Console. All further settings for Sales pro are defined by 

the user with the special administration right in the Desktop Client. 

 Open the User Management area in the Management Console. 

 Open the Properties window of the designated user. 

 Activate the Sales pro: Administrator option on the Other rights tab. 

The user responsible for administering the Sales pro module can define settings and 

defaults for the Sales pro module in the Windows client: in the Tools menu, click Set-

tings. In the Settings window, you will see the Sales pro tab. 

8.2 Changing link types 

You can change the names of the Favorites Salesperson, Salesperson 2, and Sales-

person 3 in the Management Console. Thus, the names of the Salesperson, Salesperson 

2, and Salesperson 3 link types can be fit to the individual sales structure of your 

company. 

 Open the Management Console in the Miscellaneous area. 

 Open the Link types tab in the Links area. 

 Select the link types for Opportunities in the drop-down menu. 

 Select the link type you want to change, for example, Salesperson. 

 Click Change and modify the name. 

Names can be changed for all available languages. 

 Click OK to save the changes. 

Example 

Your company works with indirect sales channels and you sell your product via sales part-

ners. They are looked after by a sales partner manager. With larger projects, the sales 

partner managers are supported by key account managers. Therefore, you change the 

names of the link types. 

 Rename Salesperson to Sales partner. 

 Rename Salesperson 2 to Sales partner manager. 

 Rename Salesperson 3 to Key Account Manager. 
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 In the Windows client, all sales partners are then displayed in the Sales partner tab. 

Click on the Add button on this tab to select the respective addresses. 

 On the Partner manager and Key account manager tabs, you add addresses from all 

internal consultants or users, and so on. 

 On the Field assignments tab, you define which partner manager is responsible for 

which sales partner and which key account manager is responsible for which partner 

manager. 

 If you create a new opportunity and select a certain partner in the Sales partner field, 

the Partner manager and Key account manager users are automatically entered in 

the respective fields. 

 If you have activated the Participant option on the Partner manager and Key 

account manager tabs, these users are also automatically entered as participants in 

the opportunity. 

 Opportunities can also easily be evaluated with regard to Sales partner, Partner 

manager and Key account manager. 

8.3 Currency settings 

The exchange rate and which currencies are displayed in the drop-down list of the Op-

portunities analysis view are defined by the administrator in the Management Console. 

 Open the Management Console in the Miscellaneous area. 

 Open the Currencies tab. 

 With New, you create a new currency data record. 

 Click Change to adjust currencies and the respective exchange rate. 

1 Special considerations with modules 

1.1 Easy Invoice 

If you are using the Easy Invoice module, you can create a customer discount list on the 

Account tab. 

1.2 Exchange sync 

In sales processes, appointments can be created as an Activity using a Template. 
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This function is not available if you are using Sales pro and Exchange sync simultane-

ously. 

1.3 Geomarketing 

If you are using Sales pro, you can display leads on maps. To do this, customers must 

have been entered and the respective addresses must have been georeferenced.  

1.4 Replication 

Leads and opportunities are replicated with all links. This applies to all link types, for ex-

ample, to customers, contact persons, and so on. The replication of these links cannot be 

disabled. Criteria catalogues and sales processes are always completely replicated. 

1.5 Report 

You can create individual report templates and edit existing report templates for lead 

analysis. 
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